# EndNote X8

## ECU Library

## Table of Contents

- **What is EndNote?** ................................................................. 1
- **Who can use EndNote?** ..................................................... 1
- **Create an EndNote library** ................................................ 1

- **Adding references to your Library** ..................................... 2
  - Manual method ......................................................................... 2
    - Manual method practice exercise ........................................ 2
  - Choosing a reference style .................................................... 3
  - Direct export method (using the Firefox browser) .................. 3
    - ECU Worldsearch .................................................................. 3
    - EBSCO Hosted Databases .................................................. 4
    - Embase ................................................................................ 5
    - Web of Science ..................................................................... 5
    - Google Scholar ..................................................................... 6
    - ScienceDirect ....................................................................... 7
    - Informit Databases ............................................................ 7

- **Managing your references** .................................................... 7
  - Groups .................................................................................. 7
  - Labels/Notes/Keywords/Research Notes ............................... 7
  - Change capitalisation in the title field ................................. 8
  - Favourites ............................................................................ 8
  - Removing duplicates ........................................................... 9

- **Cite While You Write: EndNote and Word** ............................ 10
  - Insert citations ....................................................................... 10
  - Remove citations .................................................................... 10
  - Add page numbers for direct quotes ...................................... 11
  - Modifying references in Author-Date styles ......................... 11

- **Converting citations in a document to unformatted citations** .................. 12

- **Converting citations in a document to Plain Text** .................... 12

- **Adding a Heading or making other changes to your Reference List** .......... 13

- **Creating an independent and formatted bibliography** .................. 14

- **Copying and Backing up** ........................................................ 14

- **Need Help - Endnote Support** ........................................... 14
Glossary of Terms ................................................................................................................................................ 15

Some Advanced Features .................................................................................................................................... 16

Smart Groups................................................................................................................................................... 16

Attaching Documents .................................................................................................................................... 16

Attaching full text documents using Endnote .................................................................................................. 16

Manually attaching full text documents........................................................................................................ 17

Relative path................................................................................................................................................ 17

Absolute path.............................................................................................................................................. 17

Open ............................................................................................................................................................ 17

The data file................................................................................................................................................. 17

Conversion method to add references from a PDF with DOI........................................................................... 18

Find Full text using EndNote when Off Campus............................................................................................... 18

Viewing attached PDFs from within EndNote................................................................................................. 19

Navigating the PDF Viewer Panel.................................................................................................................. 19
What is EndNote?
EndNote is a software tool that allows you to:

- Create and organise a database of your references
- Use the references in a Word document
- Automatically format your in-text citations and create a bibliography in your chosen reference style

Who can use EndNote?
Endnote is free for ECU staff and students. You can download Endnote onto work or personal PC’s. Information on how to download a copy is available from Endnote Library Guide:
https://ecu.au.libguides.com/endnote

Create an EndNote library
References are stored as records in an EndNote library. To create your first EndNote Library:

1. Open Endnote X8 (Start Menu -> All Programs -> EndNote)
2. Navigate to File -> New, and ensure you select EndNote Library (*.enl) from the ‘Save as type’ dropdown menu.
3. Re-name the .enl file and save the library to a folder (e.g. Documents/Endnote Libraries) click Save

You will see an empty library ready for you to add references.

NOTE: Your EndNote Library is independent of the EndNote program. Creating a library creates a Library file (.enl), and a .Data folder. They must have the same name and be located in the same folder for your library to work.

My EndNote Library example.enl
My EndNote Library example.Data
Adding references to your Library

Manual method

1. Click on the New Reference icon

2. Select a Reference Type (e.g. book, journal article) from the drop down menu
3. Type into the appropriate fields the details of the journal article exercise.

Manual method practice exercise

<table>
<thead>
<tr>
<th>Journal article</th>
<th>Book</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title: Cystic fibrosis and transition to adult medical care Authors: Lisa K Tuchman, Maria T Britto Source: Pediatrics, Volume 125, Issue 3, Pages 566-576, 2010</td>
<td>Title: Acute medical emergencies: a practical approach Author: Advanced Life Support Group Publisher: Blackwell Publishing Place of Publication: Oxford Year of Publication: 2003</td>
</tr>
</tbody>
</table>

4. Save and close the reference window. Click on the small X
5. Select the New Reference icon again and enter the 2nd citation for a Book.

Notes

- For authors: type the family name first, followed by a comma and the first name or initials
- For works with multiple authors enter each author on a new line; add a new line by clicking Enter after the current author’s name
- For corporate author, enter the whole corporate name and place a comma at the end: e.g. Standards Association of Australia,
- Capitalisation and spelling are not automatically changed

The reference will display in the preview pane in the reference style you have selected. X8 has a range of layout and preview options available. The default will display the preview on the right hand side. Click on the layout icon in the bottom right of the screen to change the display.
Choosing a reference style
To select a referencing style:

1. At the top of the EndNote interface is a drop down menu (it will probably say Annotated)
2. Open this menu and choose Select Another Style...
3. Click on your referencing style to select it and click Choose

Your selected referencing style should be visible in the drop down menu:

![EndNote interface with selected referencing style]


Direct export method (using the Firefox browser)
This is the most common way to get references into your library.

Direct export allows you to download citations directly from a database (e.g. CINAHL) into your EndNote Library. It provides you with the ability to collect references as you locate them. Direct export is possible from most commercial literature databases. Most browsers support direct export, although each of them do it slightly differently. Mac users: We recommend Mozilla Firefox or Google Chrome as alternatives.

When you download references from a database via direct export, they are displayed in a group called Recently Added. This is a temporary group. It exists when you import references, and is refreshed every time new references are imported. However, all references – including newly imported ones – are always available under All References.

ECU Worldsearch
1. Open your EndNote library
2. Connect to ECU Worldsearch from the library homepage
3. Conduct your search
4. Check the Star Save button next to the citations you want to export
5. Scroll up to the top of the page, click on the My List link

6. Choose the Cite button, select the reference style then the link “Export to Endnote”:

![Cite button and Export to Endnote]

7. Then choose Open with
and click OK

[Note: If you are using Chrome then the ‘citation.ris’ file appears on the bottom left-hand corner of your screen:
Click on it to populate your Endnote library.]

**EBSCO Hosted Databases**
(e.g. CINAHL Plus, MEDLINE & PsycINFO)

1. Open your EndNote library
2. Connect to the EBSCO Database (e.g. CINAHL Plus)
3. Conduct your search
4. Select the references to export by clicking on the **Folder** icon (right hand side of the page).

**Go to: Folder View**

5. Go to folder view
6. Select the references you wish to export by checking the boxes to their left
7. Click on the **Export** icon
8. On the next page make sure the top box is selected then click on the SAVE button

9. Then ‘Open with’ and OK:
Embase

1. Open your EndNote library
2. Connect to Embase
3. Conduct your search
4. Check the box next to citations you want to export
5. Click on ‘Export’

   ![Embase interface](image1)

   NOTE: There is the option to export the search strategy (green) or selected search results (red)

6. Choose the record content from the drop-down menu and click **Send**

   ![Embase export options](image2)

Web of Science

1. Open your EndNote library
2. Connect to Web of Science
3. Conduct your search
4. Check the box next to citations you want to export
5. Select **Save to: EndNote desktop**

   ![Web of Science save options](image3)
Choose the record content from the drop-down menu and click **Send**

Google Scholar

You must set up Google Scholar to allow you to export citations to EndNote. To set up Google Scholar:

2. Click on the **Settings cog** (burger bar on the top left-hand corner)
3. Scroll down to the **Bibliography Manager** section
4. Check the box **Show links to import citations into** and choose **EndNote** from the pull-down
5. Click **Save Preferences**

**Note:** Google Scholar citations can be very poor quality, for example, missing the volume number for a journal article. Use the **Find Reference Update** option under the **References** menu in EndNote to import a better quality reference from sources such as PubMed or Web of Science.

To export citations from Google Scholar:

1. Connect to Google Scholar
2. Conduct your search
3. Click the **Import into EndNote** link below the citation you want to import.

4. **Select: Open**

**Note:** You can only import one reference at a time.
ScienceDirect
1. Open your EndNote library
2. Connect to ScienceDirect
3. Conduct your search
4. Check the box next to citations you want to export
5. Click   + Export
6. Select Export citation to RIS then follow step 4 above

Informit Databases
1. Open your EndNote library
2. Connect to Informit and conduct your search
3. Check the box next to the citations you want to import and Click Save
4. Under Output Format, select EndNote Direct (‘Endnote’ option is for a txt file ‘)
5. Save

PubMed
1. Open your EndNote library
2. Connect to PubMed
3. Conduct your search
4. Check the box next to citations you want to export
5. Click on Send to:
6. Choose Destination: Citation Manager
7. Click Create file

Managing your references
As you build your EndNote library, it is helpful to organise references using functions such as Groups and Labels.

Groups
You can drag citations into a group you have created. Your references will always be visible in the ‘All References’ group. In addition, you can place references in Groups – the same reference/citation can be in multiple groups.

To create a group:
1. Right click on My Groups
2. Select Create Group
3. Type in a name for your new Group the new group will appear under My Groups
4. Click on ALL References
5. Click on a citation to select it, then click and hold to drag it into a group.

Labels/Notes/Keywords/Research Notes
You can also organise your references by adding labels, notes, keywords or research notes. You can then search your EndNote library to find the relevant/required articles. They will not show up in an output
reference.
For example to give a citation a label:
1. Double click a citation to open its edit window
2. Scroll down to the Label field
3. Type the label you want to add (e.g. ‘methodology’). To add multiple labels separate each by a space
4. Save and close the citation.

To search your library for labelled citations, select the Show Search Panel:

Select label from the field drop-down menu and type ‘methodology’ in the free text box. Select search. Any references with ‘methodology’ in the label field will be displayed.

Change capitalisation in the title field
1. Double click to open the reference
2. Highlight the Title text
3. Click on the dropdown arrow in the EndNote toolbar and select your preference.

Favourites
This feature allows you to mark your favourites with a ratings field.
Removing duplicates
As you add to your library, it is important to de-duplicate references/citations periodically:

1. Select Find Duplicates on the References menu.
2. You will be asked to select which citation you wish to retain.
Note: Selecting the duplicate to remove is easier if you have created Smart Groups.
Cite While You Write: EndNote and Word

EndNote commands are available from the ribbon in Word from version 2007. An EndNote tab will appear once you have installed EndNote.

Note:
Ignore the REFERENCES tab in Word 2007 as it does not connect to the EndNote program.

In Word 2003 and earlier the EndNote toolbar should appear in Word when you install EndNote. If not, you will find it under Tools.

Open a new Word document. For this exercise, you can create an instant paragraph of sample text by typing =rand(4,5) and hitting ENTER. Save to DOCUMENTS. Click on the ENDNOTE tab.

Insert citations
1. In your Word document place the cursor where you want the citation to be inserted
2. Go to your EndNote Library by clicking Go to EndNote and highlight one or multiple citations to insert
3. Insert the reference into the Word document using the Insert Citation icon. The program will automatically return to Word, insert the citation.
4. Endnote automatically creates a Reference List.

As you insert more citations, your Reference List will reorder automatically.

Remove citations
NOTE: You must use the EndNote ‘Edit & Manage Citations’ command button in the EndNote Word ribbon to edit any of your citations.

DO NOT DELETE citations in your Word document using the delete button as this could potentially corrupt your document.

1. In Word highlight the in-text citation you wish to remove (the citation will appear grey when selected)
2. Click on Edit & Manage Citation(s) in the Word EndNote toolbar
3. In the popup window, make sure the correct citation is highlighted, then click on Edit Reference drop down menu and choose Remove Citation
4. Click OK
This process will remove both the in-text citation and the entry for the citation in the reference list (unless you have used that reference again elsewhere in the text)

**Add page numbers for direct quotes**

1. In Word highlight the in-text citation you wish to add a page number to
2. Choose *Edit & Manage Citation(s)* from the Word EndNote toolbar
3. In the popup box, make sure you select the correct citation.
4. Using APA style: in the *Pages* box add the page numbers e.g. 45-46
5. Click OK

Remember you will have to place the quote in direct quotes.

**Modifying references in Author-Date styles**

If you are using an author-date referencing style, such as APA, there may be times where you may wish to include just the Author or just the Date in your reference. For example, if the Author is cited at the beginning of your sentence: Hunter et al. (xxx) believe that...

To modify this in your document:

1. Insert the reference as usual
2. In Word select the reference then select *Edit & Manage Citation(s)* from the EndNote toolbar.
3. In the Formatting menu, select ‘Exclude Author’ or ‘Exclude Year’ and click OK.
Converting citations in a document to unformatted citations

You can convert your Word document into an unformatted citations version (referred to as unformatted “field codes”). This is useful when working in a group or submitting your assignment or thesis electronically where changes can be tracked without corrupting the reviewers EndNote Library, as your group member, tutor or supervisor may not have the same version of either Word or EndNote.

Note this option is only useful if the reviewer is not adding citations but purely reviewing the content.

1. On the EndNote toolbar, select CONVERT CITATIONS AND BIBLIOGRAPHY then CONVERT TO UNFORMATTED CITATIONS from the EndNote toolbar.
2. Save as a new document (consider the name given to the document).
3. The new document will retain the in-text citation and reference list formatting preserved in the style selected. The references will no longer be linked to EndNote.

NOTE: It is important that the reviewer does not have their Endnote Library open while reviewing your document. (The Endnote formatting has been removed but the field code coding remains part of the document.)

4. When you receive the document back from the supervisor etc., you can then select the “update Citations and Bibliography’ option and your document will reformat the field codes into Endnote formatting.

Converting citations in a document to Plain Text

You can use Word to create an identical copy of your document without the EndNote formatting (referred to as “field codes”). This is useful when working in a group or submitting your assignment or thesis electronically.

Note: this option is best when additional citations will not be added and where track changes is not required.

Always convert your final submission to Plain text!

1. On the EndNote toolbar, select CONVERT CITATIONS AND BIBLIOGRAPHY then CONVERT TO PLAIN TEXT from the EndNote toolbar.
2. Save as a new document.
The new document will have in-text citations and the reference list formatting preserved in the style selected but the references are no longer linked to EndNote (i.e. the field code coding has been removed).

**Adding a Heading or making other changes to your Reference List**

1. Click on end references (they should appear grey).
2. To alter the layout of the bibliography, including the heading, fonts, size and spacing, select the small arrow to the bottom right of the word Bibliography in the centre of the toolbar from the EndNote tab in Word:

   ![EndNote X8 Configure Bibliography](image)

3. The EndNote X8 Configure Bibliography box will display.

4. Click on Layout tab, then add “References” under title and choose Space after (lines between) references (e.g. double). You can also change the font and size here.
Creating an independent and formatted bibliography

You can use EndNote to make a bibliography independent of any existing document using the copy/paste function.

1. Open an EndNote library and select some references (use the CNTRL keyboard button to select multiple references).
2. Right click and select COPY FORMATTED.
3. Open a Word document and PASTE the formatted references.

**NOTE:** References in the saved file are **NOT** linked to EndNote and the style be changed using the EndNote program once exported.

Copying and Backing up

Regular back-ups of your Endnote Library are essential.

An EndNote library consists of a Library file and a Data folder, and both require to be stored together for your Endnote Library to work. The Data folder contains figures, groups and other files necessary for the library.

From the **File** menu in EndNote select **COMPRESSED LIBRARY** and select which parts of the Library you wish to save. This option will make a copy of both the library file and data folder.

Save to your ‘Endnote Libraries’ folder or the name of the folder you created earlier under the ‘create an Endnote Library’ section. Alternatively, you can save back-up copies to a USB.

It is **strongly recommended** that you include a date in the name of the back-up library.

Any previous back-up libraries can be ‘archived’ by creating a sub-folder in your Endnote Libraries folder and dragging it/them into it. **Remember also to drag the data file into the sub-folder.**

[An Endnote Library consists of a Library file (.enl), and a .Data folder. They must have the same name and be located in the same folder for the library to work.]

Need Help - Endnote Support

- The Help files in your EndNote program provide a wealth of very detailed information.
- The Little Endnote How to Book is also very informative as a desktop reference: [http://dewey.thomsonreuters.com/training/Little%20Book/Little_EndNote_How-To_Book.pdf](http://dewey.thomsonreuters.com/training/Little%20Book/Little_EndNote_How-To_Book.pdf)
- FAQ’s and a downloadable EndNote user guide at [http://endnote.com](http://endnote.com)
- Training tutorials are also available: [http://clarivate.libguides.com/endnote_training/home](http://clarivate.libguides.com/endnote_training/home)
- Still require help then e-mail the library: library@ecu.edu.au
Glossary of Terms

- **Connection file** – allows you to connect to and search online databases directly from within EndNote. Connections (.enz files) come with your EndNote software and additional files can be downloaded from the internet. Save files to the Connections folder in your EndNote Program folder.

- **Data folder** - When you create an EndNote library a data folder will be automatically set up with the same name and a .data extension. Any images or files inserted in the Library will be stored here.

- **Direct export** – Many databases have inbuilt filters which allow you to export references directly from the database into your EndNote library. For Direct Export to work, you need to be working on a computer where EndNote is loaded and have the latest filters from EndNote saved into your filters folder.

- **Filter** – Databases, including EndNote, use different codes to identify the same fields of a reference such as author and title. EndNote comes with a large number of filters (.enf files) which are required to map the fields in a database record to the EndNote fields. The downloaded files have to be saved to the Filters folder in your EndNote Program folder.

- **Library** – an EndNote database of references. EndNote library files have the extension .enl. Although Endnote X8 can draw references from multiple libraries into the same document it is advisable to keep your references in a master library to make them easier to find and to avoid duplication.

- **Record Number** – EndNote assigns a unique record number to each reference. If a reference is deleted its number is not re-used. Endnote used this number to identify the reference when a Word document is Endnote formatted.

- **Reference Type** – the type of information/material you are citing/referencing will decide the format of the final brief citation and reference list entry in your library. EndNote provides templates for a number of different reference types, eg. Books, journal articles, conference papers etc. (References/New Reference tab). It automatically defaults to ‘Journal Article’.

- **Style** - Reference or output styles format the references in a document according to a particular style. The EndNote program comes with many output styles (.ens files). APA 6th is the common style used across ECU.

- **Travelling Libraries** - When you insert citations from an EndNote library into a Word document you embed some EndNote coding into your document. This creates a Travelling Library of your references attached to the Word document. You can export these references from your Word document to
another EndNote library so long as the version of EndNote and Word is compatible with your own.

Some Advanced Features

Smart Groups
A Smart Group allows you to set criteria for your group.

To create a Smart Group:
1. Right click on My Groups
2. Select Create Smart Group
3. Give your group a name and set criteria for it (e.g. a Database, keyword etc.)
4. Click Create

Existing and New references that match the set criteria will be automatically added to the Smart Group.

Attaching Documents
It is possible to store files such as full-text articles, spreadsheets, figures and diagrams in an EndNote library. Documents are saved within the data files associated with the EndNote Library and a relative path is created to them.

Advantage: the full text pdf is in your library and will ‘travel’ with the library and its data file even if they are relocated (e.g. compressed and saved on a USB).

Disadvantage: your EndNote library may become large and unstable (more potential to become corrupt). Remember also that you have so much to lose in the event of a failure of technology.

Rather than attach documents and other files to your EndNote library, they can be saved in a different place and an absolute path created to where they are stored e.g.in a file on a PC or on a USB.

Advantage: less potential for your Endnote library to become large, unstable and/or corrupted.
Disadvantage: If the Library file, the data folder or the folder with the pdf’s/files is relocated the link will be broken.

Attaching full text documents using Endnote
1. Highlight the reference/citation you wish to source the pdf for.
2. Select References/Find Full text/Find Full text
3. Endnote will conduct a search

4. If the article is found then the reference will have a paperclip icon attached to the record. However on occasions it may not be found and a ‘not found’ will appear below the ‘Find Full Text’ search

Manually attaching full text documents
Highlight the reference, Right-click and select File Attachments/Attach File. Locate the file and click Open. (NB: this method puts a copy of the file into the EndNote Data folder.)

If you prefer not to keep a copy in your Endnote Library then
1. Highlight the reference, Right-Click and select File Attachments/Attach File.
2. Locate the file and uncheck the box that says ‘Copy this file to the default file attachment folder and create a relative link’.
3. You still have access to the pdf, but you must remember not to relocate the folder that the pdf is stored in. This will break the absolute path.

Relative path
1. Open a reference in your EndNote library
2. Scroll down to File Attachments. Right Click in this field and choose Attach File
3. Browse to the document you want to attach to this reference
4. Make sure that the check-box Copy this file to the default file attachment folder and create a relative link is ticked; then click Open
5. Note that the file appears in the File Attachments field. You can double click on the file to open it.
6. Close the record and click on Yes to save. Note the paper clip now displays alongside the reference in your EndNote library.

Absolute path
1. Open a reference in your EndNote library
2. Scroll down to File Attachments. Right Click in this field and choose Attach File
3. Browse to the document you want to attach to this reference
4. Uncheck the box Copy this file to the default file attachment folder and create a relative link and click on Open
5. Note that the file now appears in the File Attachments field. To open it, double click on the file.
6. Close the record and click on Yes to save. Note the paper clip now displays alongside the reference in your EndNote library.

The data file
1. Open My Computer; locate your EndNote Library file. You should see its associated data file in the same folder. Its name will be the name of your EndNote Library with .data on the end.
2. Double click on the data folder, and double click on the folder PDF
3. Only the document saved with the **relative path** is in the folder.
4. Close the folder.

**Conversion method to add references from a PDF with DOI**
If you have PDF files of recent articles saved to your computer look for a DOI (digital object identifier) on the first page (not all files will have it). This type of file can be imported into your EndNote Library where it will automatically create an entry for itself.

1. Open your EndNote Library.
2. Click on import icon in the EndNote toolbar.
3. In the Import Data File box select Choose ‘File’, locate the PDF file you downloaded.
4. For import Option choose pdf by clicking the pull down menu.
5. Click on Import and the file will be imported and a record created for it.
6. With the Reference panel open, check the fields for any errors or modifications you may need to satisfy your reference style.

**Find Full text using EndNote when Off Campus**
If you are off campus, the following settings may increase the success rate for finding full text. (The Authenticate with field is not usually necessary on campus.)

1. Select from the Endnote X8 menu, Edit / Preferences.
2. Highlight Find Full Text.
3. In the Open URL Path field, type: `http://ecu.on.worldcat.org/atoztitles/link`
5. Select the journal article references in your Endnote Library.
6. Click on the ‘Find Full Text’ button. (If off campus, log in with your ADS password when asked and click ‘Continue’ for any other screens).
7. The articles, mostly PDFs, will download to your Library. The pdfs are stored in the Library’s data folder.

**NOTE:** If you are using a style that requires a retrieval statement, complete the NAME OF DATABASE and ACCESS DATE.
fields. The URL field will include the database name or do as part of the address.

- The amount of full text that will be found and linked to your library in this way depends on the search topic. You may find anywhere between 0 and 100% of the articles.

- Any full text articles not found by EndNote locate and download the articles to your computer.

**Viewing attached PDFs from within EndNote**

The Attached PDFs tab view, has a number of functions for viewing, annotating and sharing PDFs.

---

### Navigating the PDF Viewer Panel

1. Select a reference with attached PDFs from the reference list to view a PDF file. Move your cursor over an icon on the toolbar to see Alt text to explain its function. For example,

   - Open PDF, Save PDF, Print PDF and Email PDF

2. Right-click within an open PDF file to display a contextual menu that includes many options such as:

   - Open in Reference Window
   - E-mail Attachment
   - Remove (deletes the current PDF file)
   - Show Notes / Mark-up
   - Hides Notes / Mark-up

3. Using the Find Feature

   The Find feature allows you to search for words and phrases within a PDF document. Enter your terms in the text box and press Enter. Use the Next and Previous buttons to find the next / previous instance of a search term.

4. Adding Sticky Notes and Highlighting PDF Text

   Within the PDF Viewer, you can make annotations (sticky notes) and highlight selected text within a PDF. Both a Sticky Note and a Highlight Text icon appear in the toolbar in the PDF Viewer panel.

5. Add a Comment
• Go to a section in the PDF where you want to add a comment.
• Select the text where you want to insert a comment and
• Select the Sticky Note icon from the toolbar.
• Double-click the Sticky Note icon that appears in the PDF file to display a Sticky Note text box.
• Enter your comments in the Sticky Note text box.
• Click the Save PDF icon in the toolbar to save your changes. Note: To delete a sticky note, right-click within the PDF Viewer panel to open a contextual menu, and then select the Delete Annotation option.

6. Highlight Text

• Go to the section in the PDF where you want to highlight text.
• Select the text within the PDF that you want to highlight.
• Select the Highlight Text icon. The colour of the selected text changes to yellow.
• Click the Save PDF icon in the toolbar to save your changes.

To hide sticky notes and highlighted text, move your cursor over the text.

• Right-click to display the contextual menu.
• Select the Hide Notes/Mark-up option from the menu.

Note: Sticky note comments are searchable using the "Any Field and PDF" and "PDF Notes" options from the Field list. You can resize the Sticky Note text box to enter and view more text by grabbing a resize handle at any corner of the text box and dragging it until you reach the desired size. Sticky notes are not printable. They do not appear when the PDF file is printed. You cannot move sticky notes within a PDF file.